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R und RStudio

Was ist R?

• Eine Programmiersprache und ein Softwarepaket.

• Entwickelt von Ihaka and Gentleman (1996).

• Freier Dialekt der propietären Software S (Becker, Chambers, and Wilks (1988)).

• Weiterentwickelt und gepflegt durch R Core Team und R Foundation

• Interpretierte imperativ-objektorientierte 4GL Sprache.

• Optimiert und populär für statistische Datenanalysen.

• Große Community mit etwa 20.000 beigetragenen R Paketen (Erweiterungen)

• Evolviert und konservativ im Kern, konsistent und progressiv in R Paketen.
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https://www.r-project.org/contributors.html
https://www.r-project.org/foundation/
https://cran.r-project.org/web/packages/


R und RStudio

Wie bekommt man R?
Runterladen (z.B. https://cran.r-project.org/bin/windows/base/) und installieren.
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R und RStudio

Was kann man mit R machen?

• Datensätze laden, manipulieren, und speichern.
• Eine Vielzahl von Berechnungen an verschiedenen Datenstrukturen durchführen.
• Eine Vielzahl statistischer Analysemethoden auf Daten anwenden.
• Datenanalyseskripte schreiben und Abbildungen generieren.
• Präsentationen RMarkdown und Bücher RBookdown erstellen.

Was kann man mit R (bisher) nicht so gut machen?

• In einer ansprechenden Umgebung programmieren (⇒ RStudio).
• Scientific Computing (⇒ Python, Matlab, Julia).
• Psychologische Experimente programmieren (⇒ Python, Matlab)
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https://bookdown.org/yihui/rmarkdown/
https://bookdown.org/yihui/bookdown/


R und RStudio

Wie bekommt man Hilfe zu R?
• Googlen

• https://stackoverflow.com/

• https://www.r-project.org/help.html
• Während der Programmierung und bei bekanntem Funktionsnamen über die Kommandozeile:

?mean # Zeigt Hilfe zu der Funktion "mean()"
help(mean) # Zeigt Hilfe zu der Funktion "mean()"
browseVignettes() # Zeigt Vignetten aller installierten Pakete im Browser
browseVignettes("knitr") # Zeigt Vignetten des Paktes "knitr"

• https://rseek.org/

• https://www.rstudio.com/resources/cheatsheets/

• https://www.r-bloggers.com/
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R und RStudio

Was ist RStudio?

• Eine Softwareentwicklungsumgebung für R

• Softwareentwicklungsumgebung = Integrated Development Environment

• IDEs sind Programme zum Programmieren mit einer Programmiersprache

• Kommandozeile, Skripteditor, Vielzahl weiterer Tools

• Freemium Produkt von RStudio, Inc. (IDE frei, Server kostenpflichtig)

• Initial Release 2011, Affero General Public License

• Keine Verbindung zu R Core Team oder R Foundation

• RStudio wird im Oktober 2022 zu posit (posit.co)
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https://posit.co/


R und RStudio

Wie bekommt man RStudio?

Runterladen (https://www.rstudio.com/products/rstudio/) und installieren.
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https://www.rstudio.com/products/rstudio/


R und RStudio

Was kann man mit RStudio machen?

• R Skripte erzeugen, bearbeiten, und laufen lassen
• R Skripte in R Projekten organisieren

Laut Eigenwerbung:

• Access RStudio locally
• Syntax highlighting, code completion, and smart indentation
• Execute R code directly from the source editor
• Quickly jump to function definitions
• View content changes in real-time with the Visual Markdown Editor
• Easily manage multiple working directories using projects
• Integrated R help and documentation
• Interactive debugger to diagnose and fix errors
• Extensive package development tools
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R und RStudio

Was kann man mit RStudio machen?
Custom Layout via Tools → Global Options . . .
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R und RStudio

Was kann man mit RStudio machen?
Custom Layout via Tools → Global Options . . .
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R und RStudio

Wie bekommt man Hilfe zu RStudio?
Googlen

Zur Einführung ⇒ Using the RStudio IDE
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https://support.rstudio.com/hc/en-us/sections/200107586-Using-the-RStudio-IDE


R und RStudio

R Kommandozeile | Working in the Console

Die Basics:

• Eingabe von R Befehlen bei >

• Autocomplete mit Tab

• Code ausführen mit Enter

• Vorherige Befehle mit Cursor ↑

• Bereinigen des Konsolenoutputs mit Ctrl + L

• Code Ausführungsstopp mit Esc

Beispiel für einen Befehl:

print("Hallo Welt!")

> [1] "Hallo Welt!"

Anmerkung:

Code-Snippets in diesen Folien immer aktiv in der Konsole nachvollziehen!
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R und RStudio

R Skripte | Executing and Editing Code
Neue .R Datei erstellen

• GUI: File → New File → R Script
• Keyboard Shortcut: Ctrl + Shift + N

Bestehende .R Datei öffnen
• GUI: File → Open File
• Ctrl + O

Code im .R Skript schreiben (Befehle in Programmiersprache formulieren)

print("Hallo Welt!") # Hinter Hashtags stehen dokumentierende Kommentare
print("Hallo R!") # Kommentare werden nicht ausgefuehrt

Befehle eines R Scripts ausführen
• Einzelnen Zeile, auf welcher der Cursor ruht: ⇒ Run oder Ctrl + Enter

• Ausführen aller Zeilen: ⇒ Source oder Ctrl + Shift + Enter oder ⇒ Tickmark bei Source on Save

setzen und Ctrl + S

Anmerkung:

Code-Snippets in diesen Folien immer aktiv in einem R Skript dokumentieren!
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R und RStudio

Das R und RStudio Data Science Universum
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R und RStudio

Lehrmaterialien mit R und RStudio
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Arithmetik, Logik und Präzedenz

R Konsole als Taschenrechner

1 + 1

> [1] 2

2 * 3

> [1] 6

sqrt(2)

> [1] 1.41

exp(0)

> [1] 1

log(1)

> [1] 0

Anmerkung:

• [1] zeigt das erste und einzige Element des Ausgabevektors an
• Vektoren werden noch im Detail behandelt.
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Arithmetik, Logik und Präzedenz

Arithmetische Operatoren

Operator Bedeutung

+ Addition

− Subtraktion

∗ Multiplikation

/ Division

ˆ oder ∗∗ Potenz

%∗% Matrixmultiplikation

%/% Ganzzahlige Teilung (5%/%2 = 2)

%% Modulo (5%%2 = 1)

• Matrixmultiplikation, Modulo, ganzzahlige Teilung benötigen wir zunächst nicht.
• Ganzzahlige Teilung gibt das Resultat der ganzzahligen Teilung an.
• Modulo gibt den ganzzahligen Rest bei ganzzahliger Teilung an.
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Arithmetik, Logik und Präzedenz

Logische Operatoren

• Die Boolesche Algebra und R kennen zwei logische Werte: TRUE und FALSE
• Bei Auswertung von Relationsoperatoren ergeben sich logische Werte

Relationsoperator Bedeutung

== Gleich

! = Ungleich

<, > Kleiner, Größer

<=, >= Kleiner gleich, Größer gleich

| ODER

& UND

• <, <=, >, >= werden zumeist auf numerische Werte angewendet.
• ==, ! = werden zumeist auf beliebige Datenstrukturen angewendet.
• | und & werden zumeist auf logische Werte angewendet.
• | implementiert das inklusive oder. Die Funktion xor() implementiert das exklusive ODER.
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Arithmetik, Logik und Präzedenz

Mathematische Funktionen
Aufruf Bedeutung
abs(x) Betrag
sqrt(x) Wurzel
ceiling(x) Aufrunden (ceiling(2.7) = 3)
floor(x) Abrunden (floor(2.7) = 2)
round(x) Mathematisches Runden (round(2.5) = 2)
exp(x) Exponentialfunktion
log(x) Logarithmus Funktion

• Hierbei handelt es sich um eine Auswahl. Einen vollständigen Überblick gibt

names(methods:::.BasicFunsList)

• R unterscheidet formal nicht zwischen Operatoren und Funktionen

• Operatoren können mit der Infix Notation als Funktionen genutzt werden

`+`(2,3) # Infixnotation für 2 + 3

> [1] 5
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Arithmetik, Logik und Präzedenz

Operatorpräzedenz

• Operatorrangfolge

• Regeln der Form “Punktrechnung geht vor Strichrechnung”
• Vordefinierte Operatorpräzedenz kann durch Klammern überschrieben werden

2 * 3 + 4

> [1] 10

2 * (3 + 4)

> [1] 14

Generell gilt

• Operatorrangfolge nicht raten oder folgern, sondern nachschauen!

• Lieber Klammern setzen, als keine Klammern setzen!

• Immer nachschauen, ob Berechnungen die erwarteten Ergebnisse liefern!

?Syntax
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Arithmetik, Logik und Präzedenz

Operatorpräzedenz

Präzedenz und Ausführungsreihenfolge arithmetischer Operatoren

Operator Reihenfolge
ˆ Rechts nach links
−x,+x Unitäres Vorzeichen, links nach rechts
∗, / Links nach Rechts
+, − Links nach Rechts

Beispiele
2ˆ2ˆ3 # 2ˆ(2ˆ3) = 2ˆ8 = 256
(2ˆ2)ˆ3 # (2ˆ2)ˆ3 = 4ˆ3 = 64
-1ˆ2 # -(1ˆ2) = -1
(-1)ˆ2 # (-1)ˆ2 = 1
2+3/4*5 # 2+(3/4)*5 = 2+(0.75*5) = 2+3.75 = 5.75
2+3/(4*5) # 2+3/(4*5) = 2+3/20 = 2+0.15 = 2.15
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Arithmetik, Logik und Präzedenz

Operatorpräzedenz

?Syntax 01.10.21, 07:51 R: Operator Syntax and Precedence

https://stat.ethz.ch/R-manual/R-devel/library/base/html/Syntax.html 1/2

Syntax {base} R Documentation

Operator Syntax and Precedence

Description

Outlines R syntax and gives the precedence of operators.

Details

The following unary and binary operators are defined. They are listed
in precedence groups, from highest to
lowest.

:: ::: access variables in a namespace
$ @ component / slot extraction
[ [[ indexing
^ exponentiation (right to left)
- + unary minus and plus
: sequence operator
%any% |> special operators (including %% and %/%)
* / multiply, divide
+ - (binary) add, subtract
< > <= >= == != ordering and comparison
! negation
& && and
| || or
~ as in formulae
-> ->> rightwards assignment
<- <<- assignment (right to left)
= assignment (right to left)
? help (unary and binary)

Within an expression operators of equal precedence are evaluated
from left to right except where indicated.
(Note that = is not
necessarily an operator.)

The binary operators ::, :::, $ and @ require
names or string constants on the right hand side, and the first
two
also require them on the left.

The links in the See Also section cover most other aspects of
the basic syntax.

Note

There are substantial precedence differences between R and S. In
particular, in S ? has the same precedence
as (binary) + -
and & && | || have equal precedence.

References

Becker, R. A., Chambers, J. M. and Wilks, A. R. (1988)
The New S Language.
Wadsworth & Brooks/Cole.

See Also

Arithmetic, Comparison, Control,
Extract, Logic,
NumericConstants, Paren,
Quotes, Reserved.

The ‘R Language Definition’ manual.

Programmierung und Deskriptive Statistik | Belinda Fleischmann | Folie 26



R und RStudio

Arithmetik, Logik und Präzedenz

Variablen

Datenstrukturen

Übungen und Selbstkontrollfragen

Programmierung und Deskriptive Statistik | Belinda Fleischmann | Folie 27



Variablen

Definition

In der Programmierung ist eine Variable ein abstrakter Behälter für eine Größe, welche im Verlauf
eines Rechenprozesses auftritt. Im Normalfall wird eine Variable im Quelltext durch einen Namen
bezeichnet und hat eine Adresse im Speicher einer Maschine. Der durch eine Variable repräsentierte
Wert kann – im Unterschied zu einer Konstante – zur Laufzeit des Rechenprozesses verändert werden.

Wikipedia
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Variablen

Grundlagen

• Variablen sind vom Programmierenden benannte Platzhalter für Werte

• In 3GL Sprachen wird der Variablentyp durch eine Initialisierungsanweisung festgelegt:

VAR A : INTEGER # A ist eine Variable vom Typ Integer (ganze Zahl)

• In 3GL Sprachen wird Variablen durch eine Zuweisungsanweisung ein Wert zugeschrieben:

A := 1 # Der Variable A wird der numerische Wert 1 zugewiesen

In 4GL Sprachen wie Matlab, Python, R werden Variablen durch Zuweisung initialisiert:

a = 1 # a ist eine Variable vom Typ double, ihr Wert ist 1

• Der Zuweisungsbefehl in Matlab und Python ist =, der Zuweisungsbefehl in R ist <- oder =.

• Offiziell empfohlen für R ist <-, aus Kohärenzgründen benutzen wir hier =.
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Variablen - Beispiel

Greta geht ins Schreibwarengeschäft und kauft vier Hefte, zwei Stifte und einen Füller. Wie viele analoge Gegenstände
kauft Greta insgesamt?

Wir definieren zunächst alle Variablen:

hefte = 4 # Definition der Variable 'hefte' und Wertzuweisung 4
stifte = 2 # Definition der Variable 'stifte' und Wertzuweisung 2
fueller = 1 # Definition der Variable 'fueller' und Wertzuweisung 1

Nach Zuweisung existieren die Variablen im Arbeitsspeicher, dem sogenannten Workspace. Die Variablen können jetzt
wie Zahlen in Berechnungen genutzt werden

gesamt = hefte + stifte + fueller # Berechnung der Gegenstandsanzahl
print(gesamt)

> [1] 7

Ein Heft kostet einen Euro, ein Stift kostet zwei Euro, und ein Füller kostet 10 Euro. Wie viel Euro muss Greta
insgesamt bezahlen?

gesamtpreis = hefte*1 + stifte*2 + fueller*10 # Berechung des Preises
print(gesamtpreis)

> [1] 18

print() gibt Variablenwerte in der R Konsole aus.
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Variablen

Workspace

Nach Zuweisung werden Variablen automatisch im Workspace gespeichert.

• In der RStudio IDE wird das im Environment Pane angezeigt.
• ls() zeigt die existierenden benutzbaren Variablen im Arbeitsspeicher an

ls() # Anzeigen aller Variablennamen im Workspace

> [1] "abb_dir" "error_wrap" "fueller" "gesamt"
> [5] "gesamtpreis" "hefte" "inline_hook" "stifte"

Löschen von Variablen

• rm() erlaubt das Löschen von Variablen

rm(gesamtpreis) # Löschen der Variable Gesamtpreis
ls()

> [1] "abb_dir" "error_wrap" "fueller" "gesamt"
> [5] "hefte" "inline_hook" "stifte"

• rm(list=ls()) löscht alle Variablen

rm(list = ls()) # Löschen aller Variablen
ls()

> character(0)
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Variablen

Workspace
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Variablen

Variablennamen

Zulässige Variablennamen

. . . bestehen aus Buchstaben, Zahlen, Punkten (.) und Unterstrichen (_)

. . . beginnen mit einem Buchstaben oder . nicht gefolgt von einer Zahl

. . . dürfen keine reserverd words wie for, if, NaN, usw. sein (?reserved)

. . . werden unter ?make.names() beschrieben

Sinnvoll Variablennamen

. . . sind kurz (≈ 1 bis 9 Zeichen) und aussagekräftig

. . . bestehen nur aus Kleinbuchstaben und Unterstrichen

Anmerkung

• R ist case-sensitive. Das heißt z.B. x ̸= X

Programmierung und Deskriptive Statistik | Belinda Fleischmann | Folie 33



Variablen - Variablenrepräsentation | Binding

x = 1

• Intuitiv wird eine Variable genannt x mit dem Wert 1 erzeugt.
• De-facto geschehen zwei Dinge:

1. R erzeugt ein Objekt (Vektor mit Wert 1) mit Speicheradresse ‘0x1d888c1a800‘.
2. 2. R verbindet dieses Objekt mit dem Namen x, der das Objekt im Speicher referenziert.

x

Objekt

1

Name

Speicheradresse
"0x1d888c1a800"

y = x

• Intuitiv wird eine Variable genannt y mit Wert gleich dem Wert von x erzeugt.
• De-facto wird ein neuer Name y erzeugt, der dasselbe Objekt referenziert wie x.
• Das Objekt (Vektor mit Wert 1) wird nicht kopiert, R spart Arbeitsspeicher.

y = 1

• R erzeugt ein neues Objekt (Vektor mit Wert 1) mit eigener Speicheradresse ‘0x1da21b17843‘.
• De-facto wird ein neuer Name y erzeugt, der ein anderes Objekt referenziert wie x.

y 1 Speicheradresse
"0x1d888c1a800"

x
y

1 Speicheradresse
"0x1d888c1a800"x

1 Speicheradresse
"0x1da21b17843"

  y = x                                y = 1
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Variablen
Speicheradressen | object adress

• Speicheraddressen können mit lobstr::obj_addr() angezeigt werden.

library(lobstr) # Paket `lobstr` laden
x = 1
obj_addr(x)

> [1] "0x55e37490af78"

• y bekommt die Zuweisung x. De-facto refenziert y dieselbe Speicheradresse wie x.

y = x
obj_addr(y)

> [1] "0x55e37490af78"

• y bekommt die Zuweisung zu einem neuen Objekt (Vektor mit Wert 1). De-facto referenziert y eine andere
Speicheradresse wie x.

y = 1
obj_addr(y)

> [1] "0x55e3754ad0f8"

Anmerkungen:

• Ausdrücke der Art lobstr::obj_addr() referieren eine Funktion, in diesem Fall obj_addr(), bei gleichzeitiger
Angabe des Pakets, in diesem Fall lobbstr.

• Bevor Funktionen eines Pakets verwendet werden können, muss es mit library() geladen werden. Ausnahmen
sind R Pakete, die per default geladen werden, z.B. base.
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Variablen

Variablenrepräsentation | Copy-on-modify

x = 1 # Objekt (0x74b) erzeugt, x referenziert Speicheradresse des Objektes
y = x # y referenziert dieselbe Speicheradresse wie x (0x74b)
y = 3 # y modifiziert, modifizierte Kopie (0xcd2) wird gespeichert
y # y referenziert jetzt (0xcd2)

> [1] 3

x # x referenziert weiterhin (0x74b)

> [1] 1

1

0x74b

x
y

1
x 0x74b

x = 1                            y = x                            y = 3

y

1x
0x74b

3

0x74b

0xcd2

R Objekte sind immutable, können also nicht verändert werden.
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Variablen

Variablenrepräsentation | Copy-on-modify

Zur Immutability gibt allerdings zwei Ausnahmen, genannt Modifications-in-place

1. Objekte mit nur einem gebundenem Namen werden in-place modifiziert

x = c(1,2) # Objekt (0x74b) erzeugt, x referenziert Speicheradresse des Objektes
x[1] = 2 # Objekt (0x74b) veraendert

• Dieses Verhalten ist allerdings nur in R, nicht innerhalb RStudios reproduzierbar.

2. Environments werden in-place modifiziert (→ Environments und Funktionen).
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Variablen

Variablenrepräsentation | Unbinding und Garbage Collection

Copy-on-modify gilt auch in umgekehrter Reihenfolge
x = 1 # Objekt (0x74b) erzeugt, x referenziert Speicheradresse des Objektes
y = x # y referenziert dieselbe Speicheradresse wie x (0x74b)
x = 3 # Ein neues Objekt (0x2a08) wird erzeugt, x referenziert (0x2a08)
y # y referenziert weiterhin Objekt (0x74b)

> [1] 1

1

0x74b

x
y

1

x 0x74b

x = 1                 y = x                 x = 3

y

3x
0x74b

1
0x74b

0x2a08

1

0x74b

x

x = 1                 x = “a“

x
0x74b

1
0x74b

0x2a08

“a“

Unbinding
x = 1 # x referenziert Objekt (0x74b)
x = "a" # x referenziert Objekt (0x2a08), Objekt (0x74b) jetzt ohne Referenz

Garbage collection
• Nicht referenzierte Objekte im Arbeitsspeicher werden automatisch gelöscht.
• Das Löschen geschieht meist erst dann, wenn es wirklich nötig ist.
• Es ist nicht nötig, aktiv die Garbage Collection Funktion gc() zu benutzen.
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Datenstrukturen

Klassische Datenstrukturen einer 3GL Programmiersprache

Fundamentale Datenstrukturen

• Vordefiniert innerhalb der Programmiersprache
• Logische Werte (logical): TRUE, FALSE
• Ganze Zahlen (integer): int8 (-128,. . . ,127), int16 (–32768,. . . , 32767)
• Gleitkommazahlen (single, double): 1.23456, 12.3456, 123.456, . . .
• Zeichen (character): “a”, “b”, “c”, “!”
• Datentyp-spezifische assoziierte Operationen

• AND, OR (logical) +, - (integer) +,-,*, / (single), Zeichenkonkatenation (character)

Zusammengesetzte Datenstrukturen

• Vordefinierte Container zur Zusammenfassung mehrerer Variablen gleichen Datentyps.
(z.B. Vektoren, Listen, Arrays, Matrizen, . . . )

• Container-spezifische Operationen (z.B. Vektorindizierung, Matrixmultiplikation, . . . )

Selbstdefinierte Datenstrukturen

• Definition eigener Datenstrukturen aus vordefinierten Datenstrukturen und Containern
• Definition eigener Operationen
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Datenstrukturen

Datenstrukturenkennenlernen beim Erlernen einer Programmiersprache

Fundamentale Datenstrukturen

• Welche fundamentalen Datenstrukturen bietet die Sprache an?
• Welche Operationen darauf sind bereits definiert?
• Wie lautet die Syntax zur Definition einer Variable eines fundamentalen Datentyps?
• Wie lautet die Syntax, um vordefinierte Operationen aufzurufen?

Zusammengesetzte Datenstrukturen

• Welche Container und zugehörige Operationen bietet die Programmiersprache?
• Wie lautet die Syntax zum Umgang mit einem Container?

Selbstdefinierte Datenstrukturen

• Wie erzeugt man selbstdefinierte Datenstrukturen und zugehörige Operationen?
• Wie lautet die Syntax zum Umgang mit einer selbstdefinierten Datenstruktur?
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Datenstrukturen

Organisation von Daten in R

Alles, was in R vorkommt, ist ein Objekt.

Jedem Objekt kann eindeutig zugeordnet werden:

• ein Modus

• Atomar | Komponenten sind vom gleichen Datentyp.

• Rekursiv | Komponenten können von unterschiedlichem Datentyp sein.

• eine Länge

• optional weitere Attribute
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Datenstrukturen

Organisation von Daten in R

Alles, was in R vorkommt, ist ein Objekt.

Objekt

Modus

Atomar oder Rekursiv
Länge

Optionale
Attribute
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Datenstrukturen

Übersicht der R Datentypen

Datentyp Erläuterung

logical Die beiden logischen Werte TRUE und FALSE

double Gleitkommazahlen

integer Ganze Zahlen

complex Komplexe Zahlen, hier nicht weiter besprochen

character Zeichen und Zeichenketten (strings), ’x’ oder “Hallo Welt!”

raw Bytes, hier nicht weiter besprochen

Double und integer werden zusammen auch als numeric bezeichnet.

Viele weitere Typen, hier relevant sind logical, double, integer, character.
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Datenstrukturen
Übersicht der R Datentypen
Automatische Festlegung von Datentypen durch Zuweisung

b = TRUE # logical
x = 2.5 # double
y = 1L # (long) integer
c = 'a' # character

Testen von Datentypen durch typeof()
typeof(b)

> [1] "logical"

typeof(x)

> [1] "double"

typeof(y)

> [1] "integer"

typeof(c)

> [1] "character"

Testen von Datetypen durch is.*()
is.logical(x)

> [1] FALSE

is.double(x)

> [1] TRUE
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Datenstrukturen

Übersicht atomare Datenstrukturen in R

Datenstruktur Erläuterung

Vektor Container von indizierten Komponenten identischen Typs

Matrix Interpretation eines Vektors als zweidimensionaler Container

Array Interpretation eines Vektors als mehrdimensionaler Container

⇒ (3) Vektoren, Matrizen, Arrays
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Datenstrukturen

Übersicht rekursive Datenstrukturen in R

Datenstruktur Erläuterung

Liste Container von indizierten Komponenten beliebigen Datentyps

Insbesondere auch rekursive Struktur, z.B. Liste von Listen

Dataframe Symbiose aus Liste und Matrix

Jede Komponente ist Vektor beliebigen Datentyps identischer Länge

⇒ (4) Listen und Dataframes
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R und RStudio

Arithmetik, Logik und Präzedenz

Variablen

Datenstrukturen

Übungen und Selbstkontrollfragen
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Übungen und Selbstkontrollfragen

1. Installieren Sie R und RStudio auf Ihrem Rechner.

2. Führen Sie die Befehlssequenz auf Folie R Skripte | Executing and Editing Code aus.

3. Dokumentieren Sie die in dieser Einheit eingeführten R Befehle in einem kommentierten R Skript.

4. Erläutern Sie den Begriff der Operatorpräzedenz.

5. Definieren Sie den Begriff der Variable im Kontext der Programmierung.

6. Erläutern Sie die Begriffe Initialisierungsanweisung und Zuweisungsanweisung für Variablen.

7. Erläutern Sie den Begriff Workspace.

8. Geben Sie jeweils ein Beispiel für einen zulässigen und einen unzulässigen Variablennamen in R.

9. Erläutern Sie die Prozesse, die R im Rahmen einer Zuweisungsanweisung der Form x = 1 durchführt.

10. Erläutern Sie den Begriffe Copy-on-modify und Modify-in-place.

11. Diskutieren Sie die klassischen Datenstrukturen einer 3GL Programmiersprache.

12. Diskutieren Sie die Organisation von Datenstrukturen in R.

13. Wodurch unterscheiden sich eine atomare und ein rekursive Datenstruktur in R?

14. Nennen und erläutern Sie vier zentrale Datentypen in R.

15. Nennen und erläutern Sie vier zentrale atomare Datenstrukturen in R.

16. Nennen und erläutern Sie zwei zentrale rekursive Datenstrukturen in R.
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